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1. GLOSSARY & ABBREVIATIONS 

• Rudics = Router-based Unrestricted Digital Internetworking Connectivity Solution 

• CSD = Circuit Switched Data 

• TCP = Transfer Control Protocol 

• AFT = Automatic File Transfer 

• SCPC = Single Channel Per Carrier 

• ISDN = Integrated Services Digital Network 

• SMS = Short Message Service  
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2. SECURE, RELIABLE & COST-EFFECTIVE MESSAGING AND 

MORE 

SkyFile Mail is a messaging and compression tool that allows users to send reliable and cost-

effective emails, and SMS messages. Suitable for users at sea, on land and in flight, SkyFile 

Mail provides reliable and cost-effective email, and SMS messaging on VSAT, Inmarsat, 

Iridium, and Thuraya satellite terminals.  

Simple to install, use and update, SkyFile works on any desktop PC or laptop and is ideal 

messaging tool for users onboard.  

 

3. SKYFILE MAIL KEY FEATURES AT A GLANCE 

• Data compression: SkyFile Mail compresses data by up to 90% with a WinZip-type 
feature, significantly reducing connection time.  

• Full duplex mode: enables users to send & receive messages simultaneously.  

• Crash recovery: automatically retrieves emails if the data connection is interrupted. 

• Highly effective anti-spam filter and black & white lists block unwanted emails. Users 
can create their own black & white list according to personal needs.  

• SkyFile Mail via Iridium Rudics: boosts connection quality, service availability and 
bandwidth, reducing connection times by more than 50%.  

• Automatic notification: alerts user to incoming emails. 

• Integrated BDU access command: it allows users to automatically start/stop the IP-
session from SkyFile Mail. 

• Multi-languages: provides 9 languages which can be used independently and 
simultaneously. 

• SkyFile Remote Configuration: provides full control of all SkyFile Mail configurations, 
from billing rates to sub-account management over Marlink Portal 360 

• SkyFile Mail prepaid & MyMail: provides prepaid crew emailing functionality for 
Inmarsat and Iridium maritime terminals. 

• POP3/SMTP compatibility: No need to change your existing email tool or settings – 
SkyFile Mail is compatible with standard email software such as Microsoft Outlook, 
Thunderbird, etc.   

• OTA (Over The Air) update: no need to send an updated software on-board via CD or 
USB stick. The Master can easily download and install a new version within few clicks. 
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• GPS data provisioning: SkyFile Mail can send the position of the ship to the shore, 
allowing shipping companies to embed the co-ordinates in their tracking tool. 

 

4. NEW FEATURES 

For the new features available in the various versions of SkyFile Mail please, consult the 
release notes available on Marlink Web Site. 
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5. INSTALLATION INSTRUCTIONS 

The following pages contain detailed instructions to install the SkyFile Mail software on your 
PC or laptop.  

SkyFile Mail is compatible with Windows 95, 98, Me, NT 4, 2000, XP, Vista, Windows7, 
Windows 8, Windows 10 and Windows 11.  

In order to use the program, it is mandatory to register for SkyFile Mail via our Marlink Service. 
You will find the contact details on the last page of this manual. You can also use the self-
registration tool into Marlink Portal 360. 

If you are using a previous version of SkyFile Mail, your entire configuration is preserved 
aftseter the update installation. You do not need to uninstall older versions to update the 
software. 

If you are already a SkyFile Mail user and your PC crashes or are not able to retrieve the 
previous version, SkyFile Mail integrates a back-up solution directly on the SkyFile server. As 
such, your configuration is preserved and can be retrieved during the installation.  

You are invited to restore SkyFile Mail with an existing back-up or, if the account was already 
used before, you can restore your former sub-account configuration by loading it from the 
SkyFile server.  

The user needs full rights to change the "win.ini"-file and all files in the SkyFile-directory. We 
recommend performing the installation of SkyFile Mail with administrator rights on the PC. 

 

5.1 DOWNLOAD OF SOFTWARE FROM INTERNET 

After downloading SkyFile Mail as a ZIP file from www.marlink.com unpack it with WinZip into 
an empty temporary folder (directory), e.g. C:\Temp. Then start SETUP program (see above) 
in this temporary folder and follow the instructions in the installation program.  

Your computer must be restarted after installation to load the driver. The software will only 
function properly after this. Before restarting Windows, please remove the CD from the drive.  

 

5.2 FURTHER INSTALLATION STEPS 

The installation program sets up a "SkyFile" group in the Windows Start menu under 
"Programs", in which you will find the software. If you want SkyFile Mail to open automatically 
whenever the computer boots up, please copy a shortcut to the Autosync.exe program (in the 
SkyFile folder) in the "Auto-start" folder. The first time you start the SkyFile Mail message list 
(Windows Start menu - Programs - SkyFile - SkyFile) the setup dialogue box (in "Access and 
dial parameters") automatically opens. 
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6. SKYFILE MAIL CONFIGURATION 

 6.1 ENTERING THE ACCOUNT PARAMETERS 

• Master username: Enter the username provided by the Marlink Service Desk (your 
username is similar with the word in your email address in front of the "@"). 

• Master password: You will receive your password from the Marlink Service Desk upon 
registration. Some Windows versions only show three stars “*” after re-entering this window, this 
is in fact confusing but correct. 

• Configuration: SkyFile Mail v10.00 and following versions allows the user to define connectivity 
profiles. You can quickly switch between them and makes sense if several types of devices are 
installed on-board. For instance, you can easily configure a VSAT, a FB and an IOP and switch 
between them in case of problems of coverage. The 3 available configurations define 3 
“connectivity profiles” where the active device and the rules are associated together; connection 
and rules change at the same time. 

o Primary configuration: Please define here the primary connection (the most cost-
effective device used on-board. For instance, “VSAT”). Then define the rules for the 
Primary configuration (Size limit – Attachments rules – Type of dialing – Price, if any). 

o Backup configuration 1: Please define here the second connection (the second device 
you might have on board, for instance FB). Then define the rules for the backup 
configuration 1 (same as above). 

o Backup configuration 2: If any, please define here the third possible connection in case 
you have 3 possible devices onboard.  

Note: beginning with SkyFile Mail v10.10, it is possible to assign a new function to a SkyFile account 
named “Smart Profile Management”. Please, read the full description of this function page 24. 

• Access mode family (Quick setup): it allows you to select the type of network you want to use. 
Depending on your choice, the list of access modes will be different. 

• Access mode (Quick install): For standard satellite terminals, choose your terminal and confirm 
with "Yes" to execute the appropriate settings. For TCP/IP like Inmarsat Sailor or BGAN, an 
additional window will be displayed. 

• Number: The dial-number will be filled out automatically after selecting the access mode. 
If TCP/IP is selected, the user can select either the @IP (77.70.254.246) or the Domain 
(mail.skyfile.com). This selection is very useful to prevent unwanted background traffic. 

• Port: The port is normally set by the Quick-install-button. Please click on "Options" if you 
want to change the communication parameter. 

• Blocked address book: By choosing this option, you can restrict mobile-to-fixed 
messages to a certain group of addresses predefined in the SkyFile Mail address book. 
This parameter can be changed with the master password. 

• Login required at program start: In case you do not use sub-accounts, but still want to 
protect your SkyFile mailbox with your master-password, please select this option. 
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• Activate SkyFile Mail Prepaid services: this option must be selected in case of SkyFile 
Mail prepaid & MyMail usage. Please read the special prepaid part further below. 

• Attachments allowed for all Corporate Subaccounts: this option allows you to activate 
or deactivate the attachment function globally for all corporate accounts. 

• Attachments allowed for all Private Subaccounts: this option allows you to activate or 
deactivate the attachment function globally for all private subaccounts. 

• HTML allowed globally: this option allows you to activate or deactivate the possibility to 
use the HTML function globally for all corporate and/or private subaccounts 

 

6.2 ENTERING THE DIAL PARAMETERS 

• Do not send files bigger than [...] KByte: This parameter protects you against high 
transmission charges by accidentally attaching too large files. The limit refers to single 
attached files, not to the total email. This parameter can be changed with the master 
password. 

This limit is the maximum size which can be sent. Another limit can be set up for each 
sub-account. The sub-account-limit cannot be higher than the limit entered in this menu.  

• Minimum time between dial retries: This controls the time interval and frequency of dial 
retries if a connection has not been successful, e.g. with modems after BUSY, NO 
CARRIER etc. 

• Manual dialing (standard): With the manual method, dialing is only possible in the 
message list window. The following time settings are ignored during manual dialing. 

• Automatic dialing: In case the dial-in should be done automatically at fixed times of the 
day, you can enter the frequency / exact times at which you want SkyFile Mail to start the 
message transfer. Please note that SkyFile Mail only accepts 00/15/30/45 as minutes. 

Furthermore, the real dial-in is delayed by a random time of 0-10 min. This is to avoid 
that e.g. dozens of vessels with the same configuration are dialing-in in the same second. 
With automatic dialing, a symbol appears on the bottom right of the screen.  

Note: please create a link in the Autostart-folder of Windows to the program "host32.exe" 
(in the SkyFile-directory) to make sure, that the time schedule is running also after a 
reboot of the system. The dialing parameters are recorded in the message list under the 
menu item "Configuration" and may be changed later. 

• Automatic dialing: In case the dial-in should be done automatically within a fix time-slot 
with a special rhythm, you can enter start and end time + a period time in minutes. 
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Following the examples displayed below: 

An automatic dial-in will be done to the SkyFile server, every 22 minutes between 06:00AM 

and 06:00PM. 

 

An automatic dial-in will be done to the SkyFile Server at 6:00, 9:00, 12:00, 15:00 and 20:00 

 

The actual dialling will take place at the given time(s) plus a random variation of up to ten 
minutes to avoid busy situations when several users in a fleet use the same time.  

 

6.3 PORT CONFIGURATION (LOW-SPEED) 

Inmarsat, Iridium, Thuraya 

• Access mode family: Select “Inmarsat” or “Iridium” or “Thuraya” 

• Access mode: Select your device within the list proposed by the software. 

• Device: Select the COM port your satellite terminal is connected to. 

• Baud rate / AT-commands: Will be filled out automatically by selecting the access 

mode. 
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The preset parameters in Init. Command 1 and 2 and Dial command are suitable for almost 
all Inmarsat, Iridium and Thuraya terminals. If a connection cannot be established, please 
refer to the manual of the terminal, whether special AT commands are required. 

6.4 PORT CONFIGURATION TCP/IP & VSAT SERVICES 

From SkyFile Mail v8.25, you can control your IP-device from SkyFile Mail. It allows you to 
start the IP-session from the software. At the end of the connection, the IP-session will be 
automatically closed. This behaviour allows you to reduce the risk of unwanted data (such as 
DNS requests) which could be transferred while the session is still opened. 

To use the IP-device control, follow the instructions. 

Access mode family: Select “Inmarsat IP” or “VSAT” or “Other” Access mode: Select the 
device within the list proposed by the software 

6.4.1 Router 

If “Router” is selected, SkyFile Mail does not take in charge the control of the device. The dial 
in is manual. SkyFile will not open or close the IP-Session.  

 

6.4.2 Sample of device control with Sailor device 

Select “Sailor device control” in case “Inmarsat Sailor” has been selected into the “Access 

Mode” list. 
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6.5 SKYFILE MAIL – INSTALLATION IN A LAN 

6.5.1 Local Area Network (LAN) installation 

The SkyFile Mail client may be used on several workstations in a local area network (LAN). In 
case sub-accounts are installed, all different users could theoretically access an own mailbox 
from their PC, as long as it is connected to the LAN. 

For this purpose, SkyFile Mail only needs to be installed once on the PC connected to the 
satellite communications terminal. After installation, the SkyFile Mail installation directory 
has to be made available (mostly C:\SKYFILE) for read/write file sharing with other PCs in the 
LAN (in the file explorer you will see a hand under the SkyFile directory). 

The other workstations are connected by simply 
creating a desktop link through the LAN to the file 
"autosync.exe" in the SkyFile Mail installation 
directory.  

When using sub-accounts, we recommend 
creating a link to the transfer module 
"host32.exe" in the Windows Auto-start folder in 
order to ensure internal emails (between sub-
accounts) to be delivered instantly. Internal 
emails may be sent and received free of charge, 
using the full local email addresses including the 
sub-account names. 

 

6.5.2 Using SkyFile Mail on a terminal server 

For running SkyFile Mail in a terminal server environment, the program SlotProx in the SkyFile 
folder must always be running. It can be launched either as a normal application from a local 
account on the terminal server PC, or as a service, which is recommended. To launch SlotProx 
as a service, please follow these steps: 
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Make sure you are logged in locally at the server with administrative privileges. 

Select “Run….” From the Windows start menu and enter c:\SkyFile\slotprox – i (adjust the 
path if required). 

 

 

Use the Services Applet of the Windows control panel to start the service “Shamrock Mail-
slot Proxy”. 

The SkyFile Mail transfer host should always run in a local session with standard user 
privileges, e.g. using a Start-up link for this user to host32.exe (but not for all users!) 

A terminal server has its pros and cons. While the centralized administration is often seen as 
the main advantage, compatibility problems of some programs, a slower response of 
applications and the increased network load are downsides. Please refer to Microsoft® for 
more information. 

7. Smart profile management 

Beginning with SkyFile 10.10, it is possible to assign a new function to a SkyFile account 
named "Smart Profile Management". According to the IP detected by the server, the customer 
is set to a profile "VSAT/terrestrial", "FBB" or "IOP/other". For each of these profiles different 
restrictions and limits can be configured by Marlink, shore-side. To activate the “Smart Profile 
Management” and to define your own profile please, contact Marlink Service Desk or send 
the SkyFile Order Form v37 or following. “Smart Profile Management” function is part of the 
SkyFile Mail Entry+ and Premium packages. 

Connections from non-Marlink SIM are handled like terrestrial dial-ins and are treated like 
VSAT. Only IOP connections from the IP 12.47.179.107 are handled really service-
dependent. For all other services, the SkyFile server cannot know the associated Inmarsat 
service type. As an effect, the Smart Profile Management is working in every respect only 
while using a Marlink SIM. 

For both transfer directions, fix to mobile and mobile to fix, emails which are beyond the limit 
or forbidden by type of the message, are not transferred but stored in the mailbox. For 
example, if private accounts are not allowed to transfer mails with attachments, mails 
received for this account with attachment are stored on the SkyFile server until the ship is 
using again VSAT. If a private account is writing a mail to a terrestrial address with an 
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attachment, the mail is stored in the Outbox until VSAT is used again. According message 
boxes inform the user about this fact. 

A special situation is the case when a mail is multi-addressed to corporate and private 
subaccounts on the same ship and different rules are valid for these two account types. 
Assuming a mail is received at the server with an attachment to a corporate subaccount and 
to a private subaccount: 

• Corporate accounts disallowed; private accounts disallowed completely: 

➔ Mail is kept in the Outbox for both until VSAT is used again. 

 

• Corporate accounts allowed without attachments; private accounts disallowed 

completely: 

➔ Mail is kept in the Outbox for both until VSAT is used again. 

 

• Corporate accounts allowed with attachments, private accounts disallowed 

completely: 

➔ Mail is transmitted to the corporate subaccount only, a private account will never 

receive this email. 

 

• Corporate accounts allowed with attachments, private accounts allowed without 

attachment: 

➔ Mail is transmitted to the corporate subaccount and to the private subaccount. 

 

• Corporate accounts allowed with attachments, private accounts allowed with 

attachments: 

➔ Mail is transmitted to the corporate subaccount and to the private subaccount 

 

 

8. SKYFILE MAIL, FIRST CONNECTION 

If business and/or private sub-accounts have been already created, the following window is 
displayed when the users open SkyFile Mail. 

Select your own account in the list proposed, and then enter your password (if needed). 

Select the language in the list proposed. The selected language will be registered in the INI-
file of your sub-account. The same language will be proposed each time you will use your 
account. Different languages can be used in parallel by different people without problems. 

 

Click on “Login”. 

Additionally, if the SkyFile Mail prepaid option has been selected by the SkyFile Mail 
administrator (Master), the following window is displayed. 
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Please select your “Corporate or Private Subaccount” within the list proposed or select your 
“Prepaid” account. Please enter your password and click on “Login”. 

If the option “Self-Registration” has been enabled by the SkyFile Mail administrator (Master), 
a user (crew member or passenger) can create his own prepaid sub-account.  

 

Please click on   “New prepaid account” and follow the instructions. 

Note: With SkyFile Mail v7.5 and higher, the category of each sub account is displayed after 
the username (in brackets).  

(M) = Master 

(C) = Corporate 

(P)= Private 
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9. MESSAGE LIST 

9.1 MESSAGE LIST FUNCTIONS DESCRIPTION 

The following pages contain detailed instructions for the use of SkyFile Mail.  

Description of the items: 

• "New mail": prepare a new email. 

• “Open”: Open selected email. 

• "Answer": enables you to write and/or send an answer to a received message to the 
sender's address (and/or another Internet address). Per default, the original email is 
quoted in the answer-mail. If you want to change the default, please deselect the item  
   "Configuration" >"Quote mail in answer". 

• "Answer all": to send an answer back to the sender and to all the other recipients of the 
original message.  

• "Forward”: to send a received message to one or several other recipients in the address 
book or to other Internet addresses. 

• "Delete": deletes one or more selected messages in the message list with all 
attachments. Deleted files will be stored in the "recycle bin" archive for a defined 
period.  
Alternatively, you can use the Del key (with Shift+Del no confirmation of the deletion is  
   requested). 

• "Search”: to search for text-strings within the selected archives. If you select the 
topmost item in the archive window on the left side, all archives will be scanned.  

• "Configure prepaid subaccount": to change your prepaid sub-account parameters. 

• "Send SMS": to enter a short text message (SMS, up to 160 characters) to a GSM-mobile 
phone. The recipient can easily respond to this SMS by using the “Reply”-function of 
his phone. 

• “Call detail viewer”: to access to the call logs  

• "Address book": to enter, organize, manage and delete email addresses, SMS and 
numbers. 

• "Log-off". 

• “SPAM Report to SkyFile Server”: this function allows the user to warn SkyFile Server 
that an email is a spam and the sender a spammer.  

The user shall select/highlight the email and click on the spam-button. During the next 
dial-in the warning is sent to SkyFile server. It allows the security team to eliminate the 
spam from the mailboxes of the other user and to black-list it. The user shall use this 
function with attention because it might also impact the other SkyFile Mail customers. 
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Only emails received the last 3 days can be used and warned. 

The screenshot below shows the user interfaces of the mail program or the message list.  

You can open this message list by clicking on the SkyFile Mail icon in the Windows program 
menu in the SkyFile folder (Start - Programs - SkyFile - SkyFile). The symbol bar of the 
message list window includes the following frequently used functions: 

 

The top/right window of the message list gives an overview on the current status of the 

messages: Messages to be sent (“out”), messages which were already sent (“sent”) or 

received (“in”). The new messages are kept until the data exchange has been started (see 

"Dial now"). Received but unopened messages are shown in bold characters. 

A click on an arbitrary title changes the sorting of the messages in the message list. A click 

on the right mouse key displays a context menu in which a file can be deleted, opened or 

resent.  

Columns in the message list: 

• The "Time" column gives the local time of the email as indicated by your system clock. 
The European date format is used: day, month, year (this is not the date given in the date 
line of the email header). 

• The "Type" column shows whether a message was received, sent or will be sent. 

• The contents of the "Remark" column can be changed as required with a right mouse 
click and "change remark…" For SMS, the column contains already the indication “SMS” 
and the delivery status. 

• The "Address" column either contains the terrestrial email address or a name if known. 
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• The "size" column shows the size of the message including all attachments. A leading 
"*" indicated, that a file has been attached. 

• The “$” gives the price of each transfer. This columns is visible only if a price per volume 
or per minute has been set up on the account. 

9.2 ARCHIVE WINDOW / FULL-TEXT SEARCH 

9.2.1 Archive window 

The archive window contains all standard and self-defined archives: 

• New: contains all incoming and outgoing messages. By right click "split view" you can 
split the "new" archive into "outbox", "inbox" and "sent" (like in Outlook) 

• Drafts: If you have not yet finished writing an email, but you have to carry out another 
action, just press "exit" and you'll be asked whether the email shall be stored in the 
"Drafts" archive. 

• Pin board (or info-board): To make text information (e.g. announcements) available for 
all sub-account users, right-click on "Pin board", press "new", enter the subject and the 
text of the announcement. 

• Private/Shared archives: In order to file your messages along your personal system, 
you can create personalized archives which might also be nested tree-like. In case you 
have created a sub-account, shared archives could be created which are accessible for 
all sub-accounts. After creation, messages can be moved via drag & drop to the selected 
archive. 

• Recycle bin: In case you delete one or more messages from your message list, these 
messages will be stored in the "Recycle bin"-archive. This prevents you from losing 
emails which were deleted by mistake. You can individually define the time limit for 
storage in this recycle bin selecting "Configuration"-> "Recycle bin". With "disable 
Recycle bin", you deactivate this function. 

9.2.2 Archive Management  

Beginning with version 10.10, the SkyFile Mail client has an automatic archive management 
to avoid that mail archives get too big. Archives containing too many emails slow down the 
client significantly. Too big archives may also create problems by a huge time needed to 
modify them and, in very 
serious cases, even touch the limits of the file system. Both situations can additionally 
increase the probability of file access conflicts when SkyFile Mail is used in a network on 
several workstations at the same time. 

• Archives are renamed automatically if they exceed one of the following limits: 

o The size of archive file (extension .BIP or .BIS) exceeds 1.200.000.000 bytes 

(~1.2 GB), or 

o The mail count in an archive exceeds 1.200. 

 

• Warning messages are displayed to the user if archives exceed the following limits: 
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o The size of the archive file (extension .BIP or .BIS) exceeds 1.000.000.000 

Byte (1 GB), or 

o The mail count is beyond 1.000. 

If an archive is renamed automatically, the name is extended by "_old_[number]".  
Example: An archive with the name "charterer" is renamed to "charterer_old_001". If this file 
exceeds the limits once again later, it will be renamed to "charterer_old_002". 

The check is always done during the start of the SkyFile Mail client and during each 
POP3/SMTP connection of a SkyFile subaccount. 

9.2.3 Sharing private archives 

Beginning with SkyFile Mail v10.10, each user having subaccount in place can share his 

private archive with another user within the same LAN. 

A right-click on the name of an existing archive opens a window where the user can select 

“sharing” 

 

From that window the user can freely add or remove subaccounts/users who will have the 

possibility to consult the defined archive. 

 

Master Private Archives are not available with read and write rights to other people onboard, 

for instance from the subaccount of the Chief Engineer. 

 

9.3 FULL-TEXT SEARCH 

By pressing the "search" icon or Ctrl+F you can search for an expression or email address 
within every message shown in the currently selected archive. In case it is found, F3 
continues to search for this expression. If you select the topmost item in the archive-window, 
all archives of one sub-account will be scanned for the given expression. 

9.4 SENDING AND RECEIVING MESSAGES 

With the integrated text editor you can write or edit messages, and also optionally attach files 
to messages. The text editor is opened by clicking the "New mail" button. 

You open received emails in the message list with a double click on the relevant line. An 
outgoing email (not sent yet) can still be changed by double clicking this email. 

Functions in the text editor: 

• "To:" Clicking on the little phone book next to "To:" opens a window containing the 
address book, in which you can select your contacts. By holding down the Ctrl- or Shift-
key you can select several names. Select the required recipient by a double click or with 
"Apply". However, you can also select one of the latest addresses used, or type in 
manually one or several addresses (separated by commas). 
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• "CC:" Here you can enter one or several extra recipients. The same rules and formats 
apply to the “cc”-addresses as to the addresses in the "To" box. 

• "BCC:" Recipients entered here receive the email as "blind copy", i.e. their addresses are 
not visible to the other email recipients. You have to switch on the BCC box under "Tools" 
first ("Show BCC") or press “F6”. 

• "Subject:" Here you enter a subject for your message. When you reply to an email, the 
subject is automatically adopted and prefixed with "Re:" 

• "Add:" You can attach one or several files of any type to your text message. However, 
please check the size (see p. 4, "Do not send files bigger than [...] KByte"). 

"Text:" In this box the text of the message is entered. To insert text from a prepared TXT-
file, please press "File"->"Insert…" and select the filename. The window width determines 
the length of the line. When the window opens for the first time, it shows about 70 characters 
per line, which means that texts will be correctly printed. 

Within the text editor you are able to search for an expression (Ctrl+F). To continue the 
search, please press F3. 

To print a message with header and message-text, press the button 

Specialty for sub-accounts: If you have created sub-accounts with volume-billing, the price 
of the currently created message inclusive all attachments are shown in the bottom-line of 
the edit-window. 

Below the “Help” button, you can find a selection box with several languages. By default, you 
get English, German and French. 

This is the area where you can select your spell checker language. 

 

9.5 SPELL CHECKER (v7.60 AND HIGHER) 

SkyFile Mail uses the popular Hunspell module for spell checking. The folder DIC.DIR below SkyFile 
contains some pre-configured spell-checking files (depending on whether you have installed SkyFile 
Mail from a downloaded ZIP file or from a CD).  

Each language requires an .AFF and a .DIC file. The file name looks like this: 

<family>_<country>.AFF 

<family>_<country>.DIC 

where <family> is e.g. EN for English, and <country> is e.g. US for United States. 

You can download additional spelling files e.g. from 
http://wiki.services.openoffice.org/wiki/Dictionaries in the ZIP format and unpack the .AFF and 
.DIC files into the SkyFile DIC.DIR subfolder.  

http://wiki.services.openoffice.org/wiki/Dictionaries
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(Note: The .OXT files as used by Open Office 3.x are renamed ZIP files and can be used alternatively.) 

The spell checker will ignore quoted text (">" at the beginning of a line), links, file paths, and words 
which do not contain lower-case letters. 

Spell checker support with error display (red curls) and correction suggestions during writing 
mails on the fly. The writer can change the current dictionary with one click. SkyFile Mail is 
currently shipped with English, German and French dictionaries. 

 

 

9.6 ADDRESS BOOK 

In the SkyFile Mail message list window you can enter a list of frequently contacted email, 

SMS partner by pressing the address book symbol.  

 

• “New": Enter the name and address of a recipient here. In case you choose “SMS”, the 
address will be a GSM Number beginning with the country code (e.g. +4922872192729). 

 

Entries can also be edited and deleted by selecting the entry and clicking on the relevant 
button. 

Entries in your address book might contain a group of email addresses, with the addresses 
separated by commas. 

When you send a message, you can select several recipients simultaneously by holding down 
the Ctrl key. This considerably saves you transfer costs, as the email is transmitted to the 
gateway only once and then allocated to the individual destinations. 
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In SkyFile Mail v7.5 and higher, you can find the field “Category”. This can be a company 
name or something similar. The address book view can be sorted by name or by category. 
Additionally, it is possible to select a complete category as a group. The number of recipients 
is limited to 100 addresses. 

You can use the category-name to send an email to a group of email-addresses. 

• Select “New Mail” 

• Click on “TO:” 

• Select the group you wish to send an email to. Click on “+” 

 

The addresses, member of the group, are selected. Then click on “Apply” 

 

“Import”: If you want to provide several SkyFile Mail clients with the same address book 
content, you can create a text file with the following format: 

• Name, address 

• Name, SMS: number  

• Or “name”; “address”(comma or semicolon, quotation marks allowed) 

This file can be imported by pressing the “Import”-button. 

• “Use Windows address book”: If you use a Windows address book locally installed on 
your PC for e.g. MS Outlook or MS Outlook Express, you can easily use these entries for 
your SkyFile Mail address book by clicking this option “use Windows address book”.  
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All email addresses, and SMS numbers will be accessible now. You can even add new email 
addresses directly in your Windows address book. 

In case you have created sub-accounts, you may decide whether you wish to handle the 
entries in your address book privately or make these commonly available and visible for all 
sub-accounts. 
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9.7 SEND / SAVE FILE ATTACHMENTS 

•  Save File attachments: Depending on their type, attached files can be saved or 
immediately opened. The following safety levels are implemented. 

• Safe files: can be opened or saved (bmp, rtf, ini, gif, jpg, jpeg, tif, wav, pcx, log, pcm, dcf, 
mp3, mpg, mpeg). A warning is displayed for types such as doc, xls and ppt, because they 
may contain scripts.  

• With HTML files (.htm, .html) SkyFile client can receive HTML mails. They are displayed 
as an attachment which has to be opened in order to view it in an HTML browser like 
Internet Explorer, Firefox or others). SkyFile Mail contains an evolution which allows the 
server to create a plain-text alternative if an email contains HTML only.  

As a consequence: 

- It is then possible to search mail archives for the text 

- Quoting the original mail text in an answer is easily possible 

- Text is visible in the preview pane of SkyFile Mail before opening it 

By reducing .htm attachment to plain text, the mail volume is reduced significantly, 
typically to less than 1/3 of the original size, making SkyFile Mail more competitive in this 
case. If MS Outlook is used for sending, the volume is often reduced to 1/10 since Outlook 
creates a very inefficient HTML code. 

• Unknown file types for which no application is registered can be optionally opened with 
the editor. Executable file types such as exe, com, scr have to be saved first; they cannot 
be started prior to detachment. 

• Due to the high risk of new virus types, executable files are blocked. If the length is 
typical for known viruses, they are also blocked in ZIP files even if these are password-
protected. This happens for files with the exensions EXE, COM, CMD, PIF, SCR, BAT, LNK, 
.JS) 

• Send File attachments to attach a file to a message click on the "Add" button in the text 
editor. 

A folder (directory) window opens via which you choose the required file. Attach the selected 
file to the message by a double click. If you want to add another file, go back to "Add" again 
and insert the respective file as described. 

Another way to attach files: simply drag the respective files from e.g. the explorer and drop 
them on the SkyFile Mail “new email” window. 

Please note that the size limit must be observed. Very large quantities of data can only be 
sent if the dialing settings permit this. The protected change of this function requires a 
password. 
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9.8 MACROS / SIGNATURE 

• Macros: You will find this menu item in the “Tools” menu of a SkyFile Mail “New email” 

window.  

Macros help you to save time and typing work. Frequently used phrases, such as "Dear 

Sirs," or your contact data can be assigned to an abbreviation such as "ds" or "address". 

If you press "F2" or select "Tools" in the text editor, you will see the menu options "Edit 

macros ..." and "Expand macros". In case you have created a macro (e.g. "ds"), you can 

expand it by typing it in the text box and clicking on "Tools" - "Expand macros", or by 

pressing F2. 

• Signature: A signature is a fix text string with e.g. your name, company name and 
telephone number, placed at the bottom of each email to identify you as sender of the 
email. The signature can be used by creating a macro called “std”. The macro “std” will 
automatically be entered as a standard default in each new email. 

10. SENDING AND RECEIVING SHORT MESSAGES (SMS) 

10.1.1 Sending short messages to a GSM mobile 

From the message list you can send short messages to GSM mobiles.  

Select "Send SMS" in the "Message" menu.  

We recommend that you use the international format for the destination number, e.g. +447... 

(for a U.K. GSM number). By pressing “Send” the SMS will be stored in the outgoing mailbox 

to be delivered with the next data exchange. You will later receive a positive or negative 

delivery confirmation.1 

10.1.2 Receiving short messages from a GSM mobile 

The recipient of the SkyFile Mail SMS can easily answer by using the “Reply” function of his 

GSM mobile. The answer is then sent to the same number from where the SMS was 

received2. This is the SkyFile Mail SMS gateway number. 

 

1 Please note that this confirmation only refers to successful transfer to the mobile network, not to actual receipt by the 

addressee. 

2 To use this service, your GSM provider has to have an agreement with T-Mobile.  
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In order to initially send an SMS from a GSM mobile to a SkyFile Mail user, you have to enter 

“<SkyFile-username>: message-text” in the text and send it to the SMS gateway number; 

e.g. for an SMS to maria@SkyFile.com you need to send: 

Maria: this is an SMS via SkyFile Mail 

The SMS gateway number is usually +49 170 912 7629. It might be changed in the future in 

order to improve SMS functions. Please contact Marlink Service Desk in case you experience 

problems with this number. 

 

10.1.3 Long SMS  

SkyFile Mail Premium allows you to send longer SMS up to 1530 characters (10 segments).  

For Unicode SMS a single SMS can contain 70 characters. For longer messages each 

segment can contain 67 Unicode characters. The total max length is 670 Unicode 

characters (10 segments). 

This is the case for Asian languages or French characters with accents.  
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10.2 DATA EXCHANGE AND PROTOCOL MENU 

• Data transmission via Inmarsat An email, or short message which has not been 
transmitted via satellite yet, appears marked in red in the message list. For an immediate 
"manual" data exchange, click on the "Dial now" button in the message list. If you have 
decided to use time-controlled automatic dialing, all messages which are marked in red 
in the message list will be automatically dispatched at the intervals defined by you. 

• Messages are received and sent simultaneously. To check whether you received any 
new messages, a data exchange has to be carried out. All messages will be compressed 
automatically by the SkyFile Mail system. The compression rate depends on the type of 
file, for TXT or Word-files compression rates amount up to 90%. So you do not 
necessarily have to compress attachments in advance. 

 

During transmission of a large attachment, you can see the file name in the host window. If 
you feel that the transmitted file is an unwanted one, click on the "Reject file"-button. This 
stops the transmission of the attachment and the respective file is deleted at the gateway. A 
re-transmission is not attempted. However, all other attached files and the text of the email 
will be received. 

If the connection drops down within a data-exchange, SkyFile Mail will continue the 
transmission of the messages at the point of interruption to save online-times. 

 

• Protocol (log) function. In the "File" menu you can constantly check (“Logs” ➔ “View 
logs”) your connections made, which files were exchanged, rough duration of 
transmission, and whether any problems occurred during transmission. The protocol 
data can be deleted any time ("Logs" ➔ "Delete logs…"). 
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• View logs of alternate email program  

SkyFile Mail v8.25 Premium allows customers to use an alternate email program like 

Microsoft Outlook or Outlook Express. This menu gives you access to these specific logs: 
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 10.3 CALL DETAIL VIEWER 

If you are a SkyFile Mail Premium user, you have access to the Call Detail Viewer 

How to access the menu 

Go to “File”  “Call Detail Viewer” 

Please read the Disclaimer carefully 

The Call Detail Viewer provides you with a clearer and more understandable way to consult 

your call logs. 

An export function allows you to export these files in CSV format. 

 

 10.4 BACKUP / RESTORE  

A crash of the PC could destroy all valuable data on your PC. In order to avoid losing any 

important SkyFile Mail data, the backup-restore function enables you to save all messages, 

archives, address-book data, API-setup as well as sub-account configuration data in a 

backup-directory and then restore it easily if needed.  

From SkyFile Mail v9.00, 3 backup processes are available: 

• Manual backup without reminder 

• Manual backup with regular reminder to the master 
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• Automatic backup at fix-time, for instance every day at 3:00utc 

Backup  

Please select a directory where the data shall be stored to. To increase security, we 

recommend selecting another partition, hard drive or even through the network another PC. 

Then you could specify for which kind of data a backup shall be created. 

 

• Specialty for sub-accounts The full backup of all configuration data is only possible if 
you are logged in as master sub-account. Else backup is only possible for the sub-
account-archives. 

• Restore 
To restore archives or configuration data please select the directory where the backup 
has been stored to. If the directory is valid, you will see all the backup-data with the 
respective date when the backup has been made. Please select the data you want to 
restore and press OK. In case sub-accounts with several archives shall be restored, you 
will be asked for each archive separately.  

Please be aware that restoring data always will overwrite the current data. E.g., if you 

create new sub-accounts or get new messages after you have performed the last backup, a 

restore will delete them.  
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10.5 Archive Management 

The Archive Management section, available via the File section, allows you to decide how 

and when SkyFile Mail Client should do the archiving of the data. To ensure SkyFile Mail 

client to work good with a maximum of efficiency, it is strongly recommend to manual or 

automatically create archives. 

 

10.6 OUT OF THE OFFICE MESSAGE 

SkyFile Mail users have the possibility to activate an auto-reply message from the SkyFile 

Mail client software. The text should be entered in a text box. It is limited to about 200 

characters. 

In order to avoid mail loops, SkyFile Mail client will memorize the last few addresses where 

auto replies have been sent to so that no more replies will be created for repeated mail from 

the same sender. 

Every time a sub-account is opened in SkyFile Mail, a reminder is displayed that auto- reply 

is active for this sub account. 

To activate the auto-reply, please go to “configuration” “Out of office”. 

The transmission of the auto-reply message is free of charge. 
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11. OTA (Over the air) update 

From SkyFile Mail v9.00 the master is informed by a pop up when a new version of the 

software is available and he can receive and install it within a few clicks. As such the user can 

be sure to use always the most recent software. Furthermore, when it is technically possible, 

only an incremental part of the software is transferred reducing the volume of the transfer 

significantly. 

To know more about the available versions, the master can directly go to “Configuration” 

“SkyFile update OTA” 

Depending of the service subscribed, the master will be able to download and install: 

• SkyFile Mail Client 

• SkyFile Anti Virus Entry and Premium 

• SkyFile NOAD 

• ITLINK 

 

• “info” provides details about the changes between the previous and the newest 

version 

 
• “Download” starts the download of the software. Please note that the download 

process uses the standard exchange protocol (host32.exe). It means that it benefits of 
the compression and of the crash&recovery functions, making the transfer more 
efficient and less expensive. 

 At the end of the download the master is informed and he is invited to check them 

right away.  

The check can be postponed without problems. 

• “Install” starts the installation of the new version of the software 

 

The installation of the software takes few seconds and it does not require any IT-

knowledge. 
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12. SERVICES ACCESSIBLE FROM THE SHORE 

12.1 WEBMAIL INTERFACE 

The SkyFile Mail webmail interface provides you with direct access to your SkyFile Mail 
mailbox via the Internet. This makes it very convenient to read, delete, answer or forward 
emails received in your mailbox which has not been transferred to the satellite 
communications terminal yet, as long as an Internet connection is available.  

Important: The webmail is an option, to activate it please contact Marlink Service Desk 

To access your mailbox via webmail, please open your standard internet-browser with the 

URL "https://webmail.skyfile.com/". After entering the "Master username" and the "Master 

password" (same password you need to enter in the setup of the SkyFile Mail software), you 

will see the list of fix-to-mobile messages (which have not been sent yet) in your SkyFile Mail 

mailbox. 

Since SkyFile Mail v7.5, all categories of sub-accounts (Corporate, Private & Prepaid) can 

use SkyFile webmail. 

To learn more about SkyFile webmail, contact our Marlink Service Desk or consult our 

website where a user guide is available. 
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12.2 GPS data provisioning 

Since the version 9.00, SkyFile Mail can send the position of the ship to the shore, allowing 
shipping companies to embed the co-ordinates in their tracking tool. SkyFile Mail provides 
the GPS information no matter what type of terminal is used (FB Sailor, Furuno, JRC etc). The 
positions are captured at fix times and are sent to the shore side during each dial in. This 
service is part of the Premium package. It can also be ordered as a SkyFile Premium On 
Demand service, invoiced separately. 

To learn more about this service please, contact our Marlink Service Desk or your Service 

Provider. 

12.3 Mail Manager in P360 

Mail Manager allows a shipping company or a Service Provider to manage their SkyFile Family 

accounts and configurations as well as their SkyFile Mail traffic and perform their daily 

communications operations more effectively. Mail Manager provides you with advanced 

reporting, highly flexible user rights and grouping options. 

To learn more about P360 and Mail Manager please, contact our Marlink Service Desk or your 

Service Provider. 
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13. GENERAL SPLIT BILLING  

In case you require a detailed monthly paper or electronic bill showing each single message 

(email, SMS, fix-to-mobile as well as mobile-to-fix) instead of the SkyFile Mail data call, 

please register for the “Split Billing” option via Marlink Service Desk. The split is done on the 

basis of the resources of each message which have been required for the respective data call. 

For this option, it is mandatory to register your Inmarsat data-IMN or Iridium/Thuraya MS-

ISDN for this SkyFile Mail account through our Marlink Service Desk. 

 

Please note: Choosing the split billing option will not affect the amount of your monthly bill 

(apart from minor rounding differences3). It simply provides you with a detailed overview of 

all messages transferred. 

This detailed list will be very helpful for anyone who has to split the communication costs 

between several parties (e.g. ship-owner, charterer, crew, private...). 

 

3 Please note that each message will be rounded at least to 1 sec. and you’ll be charged for this duration. 
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13.1 HOW TO ACCESS TO THE BILLING MENU 

The billing menu is accessible under “File” “Billing” 

The menu is protected. Access requires to enter the root-account credentials. 

Please read the disclaimer before continuing. Here you can calculate and create bills for all 

accounts or specific ones. You can also export them into CSV files 
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14. AFT (automatic file transfer) 

14.1 AFT SERVICE DESCRIPTION 

AFT makes it possible to manage data transfers of ship management systems via the 
optimized protocol of SkyFile Mail. Apart from standard Windows mechanisms MAPI and 
MailTo-interface (both only for mobile-to-fix transmissions), AFT allows you the bi-directional 
exchange of data files (fix-to-mobile and mobile-to-fix) via user-defined windows-directories. 

You will access the a setup-window in the menu "Configuration" ➔ "Automatic File Transfer 
(AFT)" 

 

Thanks to the flexible time schedule module (see chapter "Entering the dial parameters"), the 
data transfer can be carried out fully automatically. 

If you need to retrieve files sent and/or received, please select the “backup” option. 

Your files will be then copied in a special folder created under SkyFile Mail main repertory, 
named: API_OUT.DIR and API_IN.DIR 

To learn more about SkyFile Mail AFT settings, please contact our Marlink Service Desk or 
consult our website where a user guide is available. 
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15. ALTERNATE EMAIL PROGRAM – SMTP/POP3 

15.1 SMTP SERVER CONFIGURATION 

SkyFile Mail v8 and higher provide an SMTP-module. The SkyFile transfer host includes an SMTP server 
which can be used by 3rd-party applications (like sensors, cameras etc.) to send files over SkyFile Mail 
to local or external addresses if corporate sub-accounts are configured. The configuration menu item 
"3rd-party applications" requires a log-in with the master credentials and shows these fields: 

• Enable SMTP for 3rd-party applications: This option enables or disables the SMTP 
server. The default is ”Off”. 

• SMTP port number: The typical port number is either 25 or 587. Please make sure that 
the configured port is not used by any other program on the same PC and that the SMTP 
client software is configured for the same port. Probably the configured port has to be 
allowed in the local firewall. 

• Allowed IP ranges: Several ranges in the CIDR format (like 192.168.0.0/16) or single 
addresses (like 192.168.0.35) can be entered with spaces as delimiters. Do NOT enter 
any public IP range here otherwise your system may be abused as a spam/virus relay! 
The default ranges are: 192.168.0.0/16 127.0.0.0/8 169.254.0.0/24 172.16.0.0/12 

• Allowed IP ranges without authentication: Some applications do not allow an 
authentication. In this case you can enter addresses or CIDR ranges as a subset of 
"Allowed IP ranges" from where no authentication is required. By default this field is 
empty. 

• Trace to log file: If this option is enabled, the complete SMTP dialogue except the 
authentication credentials will be written to the transfer log file HOST_LOG.TXT. If it is 
disabled, only one line will be written for each email. Default is ”Off”; the option should 
only be enabled temporarily for diagnosing problems. 

15.2 SMTP CLIENT CONFIGURATION 

The SMTP settings in the sending application must be configured as follows, their names might slightly 
differ: 
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• SMTP host name: The computer name or local IP 
address of the SkyFile Mail PC. 

• SMTP port: Same port as configured in SkyFile Mail, 
typically 25 or 587. 

• Authentication: Enabled, "login" method (secured 
authentication off), user name and password as 
configured in a corporate sub-account of SkyFile Mail. 

• Email address: The full external address of the sub-
account, e.g. master.titanic@skyfile.com. Note that the 
sub-account must be the same as the one used in the 
authentication setting. 

• HTML formatting (if available): ”Off”, use plain text 
instead. 

15.3 SMTP AND POP3 

SkyFile Mail v8.25 offers the possibility to use an alternate applications such as Outlook, 

Outlook Express, Thunderbird to send and receive emails and SMS. 

POP3/SMTP features are part of SkyFile Mail Premium offer. To learn more about SkyFile Mail 

Premium, please contact your Key Account Manager or our Marlink Service Desk. 

To learn more about SkyFile Mail Premium, please contact our Marlink Service Desk or 

consult our website where a dedicated user guide is available. 
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16. ADDITIONAL FEATURES 

• Data size limit (fixed-to-mobile / optional) 

To protect against unwanted emails with large attachments (and consequently time-

consuming data transmissions), you can set an individual data size limit for attachments 

of incoming emails: 0,1 MB, 0,5 MB, 2 MB (standard configuration) or 10 MB. If larger 

attachments are sent to your address, you will only receive the address details and the 

pure text of the email to which you can reply. Please register for this service via Marlink 

Service Desk. It is possible to by-pass this limit with your white-list features. 

• Mailbox / Urgent notification (optional) 

To inform mobile users about incoming messages in their terrestrial SkyFile Mail mailbox, 

SkyFile Mail can notify users via short notification, in case there is a new message in your 

previously empty mailbox. Alternatively or even additionally you can register for "urgent 

notification". Then a notification is sent in case the subject line contains the string 

"urgent". The notification can be sent to a GSM mobile (via SMS4), an Inmarsat C terminal 

or an Iridium handheld. This service is free-of-charge, apart from Inmarsat C (1 segment 

per notification). This feature saves you from expensive dial-ins into empty mailboxes. 

Please register for this service via Marlink Service Desk. 

• 24hours NDN (24hours Non Delivery Notification) 

In case a shore-to-ship message is not retrieved by the ship after 24hours of storage in 

the mailbox, a notification is sent back to the sender. No need to send the message again.  

• Repetitive NDN (optional) 

This option is part of SkyFile Mail Premium package; it shall be activated by the Marlink 

Service Desk. In case a shore-to-ship message is not retrieved by the ship after a time-

frame defined by the user and set up in SkyFile Server (e.g. after 2 or 4 hours), a 

notification is sent back the sender. This notification includes a web-link allowing the 

user to remove the message is this want is obsolete.  

• Mailbox advanced notification to Inmarsat C (Optional)  

An advanced notification has been introduced in September 2011.  

-   A standard notification contains 2 words only (the name of the account and the word 
“mail”). 

-  An advanced notification to Inmarsat C contains the following elements: 

 

4 Your GSM provider has to have an agreement with T-Mobile. 
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- Line 1 = 20 stars 
- Line 2 = “new SkyFile email to: [email destination containing sub-account and root 
account] 
- Line 3 = Sender: [email address of the sender] 
- Line 4 = Subject: [subject of the email] 
- Line 5 = attachments: [yes or no] 
- Line 6 = size: [total size of the email] 
- Line 7 = 20 stars 

Example 

******************** 

new skyfile email to: master.arcachon-wave@skyfile.com 

sender: Marlink_shipping@orange.fr 

subject: loading plan and travelling modifications 

attachments: yes 

size: 2145 bytes 

******************** 

• Confirmation (fixed-to-mobile / optional) 

If you choose this option, SkyFile Mail will inform the terrestrial sender of an email as 

soon his email with all the attachments has been fully transmitted to the receiver 

terminal. Please register for this service through our Marlink Service Desk. 

Since SkyFile Mail v9.00, the user can select what type of confirmation he wants to 

receive.  

o NDN(*) only 

o NDN with quotation of the original email 

o PDN(*) and NDN  

o PDN and NDN with quotation of the original email 

(*) NDN = Negative Delivery Notification – PDN = Positive Delivery Notification 

• Subject keyword (fixed–to-mobile / optional):  To restrict the group of users who are 
authorized to send mails to your SkyFile Mail account and for SPAM prevention, you can 
apply for a subject keyword. In this case, emails addressed to your terminal are only 
forwarded to you, if the keyword is entered in the subject line. The subject keyword will 
not be delivered to the mobile SkyFile Mail user. Please note: The subject keyword differs 
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from the master password which you received previously via Marlink Service Desk. 
Please register for the subject keyword via Marlink Service Desk. 

A configured subject keyword is not required if the terrestrial sender is white-listed in the 
black & white list (preceded by + or # in the list). The subject keyword is not required for 
prepaid sub-accounts since these are typically personal accounts.  

• Weekly Configuration Report (optional): For a better management of SkyFile Mail 
accounts we have introduced the possibility for weekly captioning of completed and 
detailed configurations. This option is activated on demand. Please contact our Marlink 
Service Desk. 

A file containing the account-details will be sent automatically to your Remote 
Configuration supervision email address each Friday. 

Information provided: 

- SkyFile Mail account configuration on the SkyFile server 

- Sub-account description 

- Black & white list description 

Font 

The font menu is accessible from “configuration” menu. The three font-type settings are: 

• Fixed (default): This font for reading/writing messages is exactly the same as in previous SkyFile 
Mail versions. 

• Proportional: A proportional font can be used for better readability of most emails. 

• Automatic: If a mail does not contain more than two sequences of 3 spaces (i.e. it does not contain 
tables or similar elements which require a fixed font) then a proportional font is used, otherwise 
a fixed font. 

In general, the "automatic" setting is preferred by many people because it increases readability 
significantly for most emails while keeping the correct fixed formatting for mails with tables and similar 
content. There are also two more key functions in SkyFile Mail v7.5:  

• F11 = switch to full screen or back (as in many other programs);  

• F12 = switch fixed/proportional font, see above. 
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17. multi login 

Generally, using the same subaccount on different working-stations is forbidden. This 

restriction is due to the fact that this kind of usage might generate conflicts between accounts 

and users. This is the reason why we do not support officially this option and also the reason 

why we won’t be responsible if issues occurred on-board the ship because of that. However, 

as shipping-companies are typically using this configuration we inform you about possible 

options to use the multi log-in on your own risk. 

An option has to be manually added in a configuration file of SkyFile Mail. 

17.1 SkyFile Mail v8.26 and anterior 

• Close SkyFile Mail 

• Go to SkyFile Mail folder (usually C:\SkyFile Mail) 

• Open the file “CP.INI” 

• At the end of the existing list of elements please, add the following entry: 

[Options] 

Multilogin=1 

• Save the file and restart SkyFile Mail Client 

17.2 SkyFile Mail v9.00 and following 

• Close SkyFile Mail 

• Go to SkyFile Mail folder (usually C:\SkyFile Mail) 

• Select the user (subaccount) who requires this function (e.g. “master”) 

• Open the file “USER.INI” 

• At the end of the section “[Settings]” please add 

• Multilogin=1 

• Save the file and restart SkyFile Mail Client 
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Example: 

[Settings] 

AutoDrafted=0 

Trashcan=10 

Tray=10 

Autoresponder=0 

FontType=Prop 

FontSize=Medium 

Language=English 

CDRWarning=10 

LastPop=1395420249 

MultiLogin=1 
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18. Help & configuration status 

From the “HELP” menu of SkyFile Mail Client, you can access to configuration & status files 

• Contacts 

Here are located our contact details. Phone numbers and email addresses depend of 

the SkyFile package you are using (Classic or Premium) 

 

• Manual & FAQs 

Here is located SkyFile Mail Client user guide 

 

• Version information 

In that section, you will get the list of changes which have been made since the version 

6 of SkyFile Mail Client. 

 

• Premium information 

Please find here the description of the services/features which are part of the package 

subscribed by the shipping-company. This is a dynamic section. If a new package is 

subscribed, the list of services/features is updated automatically.  

 

• Configuration status 

This menu is located in the “configuration” menu. Here are located the elements of the 

configuration of your SkyFile Mail Client. This file is very useful for the technicians if 

trouble-shoot is necessary.  
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19. SUB-ACCOUNTS – ADMINISTRATION WINDOW 

19.1 SUB-ACCOUNT DESCRIPTION 

This feature is very helpful when you have a group of SkyFile Mail users on a single PC or in a 

local area network (LAN). While e.g. onboard a ship the standard email address simply is 

<shipname>@SkyFile.com, sub-accounts allow an additional name and a dot before this 

standard address, such as: <subaccount>. <shipname>@SkyFile.com.  

This allows different persons or parties (e.g. charterer or crew-members) onboard having 

their own personal email addresses (e.g. charterer.vessel@SkyFile.com). 

The administration of sub-accounts is handled via the menu “Subaccount”; Here you can 

create, edit and delete sub-accounts. 

3 categories of sub-accounts are available:  

• Corporate 

• Private 

• Prepaid & MyMail  

According to your own usage or needs, you can display “All” categories or only part of them. 

To display the sub-account category needed, please click on one or several box(es). 

 

• Copy all messages to master account: For control reasons a copy of all messages from and 
to corporate sub-accounts (see "Sub-accounts – creation 1") might be copied into the 
master sub-account message list. So the captain will be able to control all transferred 
emails on-board the vessel. 

The master can be in copy of ship-to-shore and/or shore-to-ship emails.  

 

• Message without sub-account addressing to master sub-account: Once sub-accounts 
are created, messages without the sub-account addressing, e.g. "vessel@SkyFile.com" 
will still be received by the master sub-account if this option is selected. 

• Master sub-account: Following the creation of sub-accounts, it is mandatory to select 
the “Master sub-account”. This sub-account is then defined as the “administrator” of the 
system with full “admin-rights”.  
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• Set different pricing rates for each subaccount: With SkyFile Mail v7.5 and higher the 
price can be defined for all sub-accounts. If the option “set different pricing rates for each 
subaccount” is selected the same configuration is applied to all sub accounts.  

19.2 SUB-ACCOUNTS – CREATION 

SkyFile Mail differentiates between 4 categories of sub-accounts: 

• Corporate: Messages of these sub-accounts may be accessed by the captain (master 
sub-account); they are shown in the web mail interface. 

• Private: These sub-accounts are fully private and cannot be accessed by the captain. 
With SkyFile Mail v7.5 and higher private sub-accounts are shown in the SkyFile webmail 
interface. Only the owner is able to check messages in his private sub-account. For 
crew/passenger emailing, please always define these sub-accounts as “private”. 

• Prepaid: These sub-accounts are usable with our Universal Card™. In general the usage 
is dedicated to crew-members or passengers. Sub-accounts are fully private and 
protected by a mandatory password. 

• MyMail: With SkyFile Mail v7.5 and higher 
the master has the possibility to create 
MyMail prepaid account. This mobile account 
is not linked to one specific SkyFile master-
account anymore. The user is able to move to 
another vessel and can still use the same 
email address. 

• Description: Name of the sub-account 
holder, such as "Josh Randall" or “Cook” 

• Sub-account name: The part of the email 
address in front of the first dot, such as 
"Cook". The email-address will then be e.g. 
"cook.myvessel@SkyFile.com". 

• Password (optional): If you define a 
password here, the user has to enter this sub-account password to access his private 
message list. 

• Private sub-account: To create a "private" sub-account, please select this field, 
otherwise the sub-account will be "corporate". If you choose "private", the respective 
password has to be changed by the private user as soon as he enters his message list for 
the first time (indicated by "User must change password"). This ensures that the captain 
or the administrator is not able to access emails in private sub-accounts.  

• Create new MyMail prepaid account: if the prepaid option “self-registration” is not 
activated, then this option is active. It gives to the master the possibility to create 
Prepaid/MyMail account on behalf of the crew-members. 

• User must change password: if selected the user will be invited to change his password 
at the first connection. This makes the subaccount fully private. 
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• Access to shared archives: Please deselect this option in case the sub-account may not 
access the shared archives e.g. for passenger sub-accounts. Billing based on message 
size: With this selection you can choose, whether this sub-account shall be billed 
duration-based (in minutes) or volume-based (in Kbytes). This selection only has an 
influence on the on-board-billing feature. The general monthly bill from us will always be 
duration based. 

• Only internal emails allowed: if this option is selected the user won’t be able to send 
and receive any external emails. Only internal emails with and without attachment will 
be accepted.  
“Internal emails” means “emails within the local network on-board the ship”. 

• Sending emails allowed: the captain can here restrict the usage of this subaccount to 
incoming emails only. If the option is not selected, the user won’t be able to send any 
emails. The usage can be restricted to emails only without attachment. 

• Receiving emails allowed: the captain can here restrict the usage of this subaccount to 
outgoing emails only. If the option is not selected, the user won’t be able to receive any 
emails. The usage can be restricted to emails only without attachment. 

If the reception of attachments is disallowed, the user will receive the body of the mail 
anyway. A short notice, delivered within an attachment, will inform the receiver that the 
original attachment has been removed because of the internal policy applied on-board 
the ship. Furthermore, the sender of the mail will be informed by a notification that the 
mail body has been delivered and the attachment filtered. 

Please consult the notifications in annex. 

• Allowed to start mail exchange: This option selects whether a sub-account is allowed 
to initiate a dial-in (this is usually done by the master sub-account but this privilege might 
be extended to another sub-account, the captain for instance).  

Please note: If this option is activated, this sub-account gets at the same time access to 
the SkyFile Mail administration menus. 

• Keep a copy of all SMTP/POP3 emails in SkyFile (SkyFile Mail Premium only): please select 
this option is you wish to keep a copy of all incoming and outgoing emails in SkyFile Mail. 
Emails will be stored in your alternate email program AND in SkyFile Mail. 

• Extended format (HTML, Header) allowed: if the subaccount is used by a POP3-based 
client program, HTML-formatted emails can be allowed here. Otherwise the server will 
convert them to plain text which saves some satellite transfer volume and time. Since 
SkyFile Mail v9, this option allows the full header of the emails too. Then, if this option is 
selected, HTML-formatted emails and full headers are accepted. 

• Deliver logs and alerts via POP3: If this option is activated a short notification will be 
sent to your alternate email program when the emails are sent to the shore over the air. 
Since SkyFile Mail v9, the alert messages are also transferred to the sender via a short 
notification. 

• Mail size: Please select the mail size accepted for this sub-account. 
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• Limit: If you enter a limit, no mails can be sent or received from this sub-account in case 
the online time, byte counter or money counter has exceeded this limit. “0” means the 
sub-account is unlimited.  

Please note that the reception of emails stops only after the next dial-in after the limit 
has been reached! So it might happen that the limit set will be exceeded for a certain 
amount. 

• Money-based limit: Enables the captain to enter a money-amount as a limit, based on 
the previously entered crew-fee (price per min/Kbyte). 

• Monthly limit: If you choose a limit, the online time, byte counter or money counter will 
be automatically reset at the end of the month. After this reset the limit is again available 
for the next month. This makes sense in case of a regular monthly billing of the sub-
account users. 

• Clear online/byte counter: In case the monthly limit is not selected, the online time can 
be reset by pressing this button. This makes sense in case a crew-member has paid the 
bill in the middle of the month to get a new credit. The current online time, byte counter 
or money counter is displayed for your information on the right hand side of this button. 

To configure the price please go to “Price Configuration”  

 

• Always bill mail volume: if selected the bill of this sub-account will be done on email-
volume and the price determined by the one mentioned in the field “Price per Mbit”. 

• Always bill connection times: if selected the bill of this sub-account will be done on email 
connection-time and the price determined by the one mentioned in the field “Price per 
minute”. 

• Billing mode depends on real connection type (LCR): if selected both prices are taken in 
consideration by the software and will be displayed in the user-bill according to the 
connection done. 

• Price per minute: The crew-fee per minute, based on the currency in the next field. This 
fee is not applied to internal emails. 

• Price per MBytes: the crew-fee per MBytes, based on the currency in the next field. This 
fee is not applied to internal emails. Since SkyFile Mail v9, the value is indicated in Mbytes 
while it was in Mbits in the previous version. The conversion from Mbits to Mbytes is 
automatic and done during the update of SkyFile Mail. “Mbits” remains for MPDS only. 

• Minimum price: This fee will be simply added to every single email sent from this sub-
account. This fee is not applied to internal emails. 



 

 

SkyFile Mail | User Guide | Full version © Marlink ● Page 53/70 

• Currency: Please enter the currency here, e.g. "EUR" or “€” or "USD" or “$” 

 

 

19.3 How to keep original root-account? 

By default the original root address (e.g. neptun@SkyFile.com) is replaced by the master 

sub-account, as soon as the first sub-account has been created. In case customers want 

to keep the root address (neptun@SkyFile.com) the master sub-account must be set as 

neptun.neptun@SkyFile.com. The shore-side will then receive mails sent from 

neptun@SkyFile.com.  

 

Example:  

Root account = neptun (neptun@SkyFile.com) 

If you want to keep it, set master sub-account to = neptun.neptun@SkyFile.com.  

If “Message without sub-account addressing to master sub-account” is selected, the 

message received on shore will be neptun@SkyFile.com (Instead of 

neptun.neptun@SkyFile.com) 

  

mailto:neptun@SkyFile.com
mailto:neptun@SkyFile.com
mailto:neptun.neptun@SkyFile.com
mailto:neptun@SkyFile.com
mailto:neptun@SkyFile.com
mailto:neptun.neptun@SkyFile.com
mailto:neptun@SkyFile.com
mailto:neptun.neptun@SkyFile.com
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19.4 SUB-ACCOUNTS – ONBOARD BILLING 

In case a sub-account is used by a crew-member or a passenger for private issues, in most 

cases ship-owners re-invoice the user for the used online-time. In order to enable the captain 

to provide him with a bill at any time including a detailed invoice, SkyFile Mail produces on-

board-bills. Choose "File" ➔ "Billing", select the needed sub-account and month, and then 

press "Calculate & Create Bill". 

 

Each single message (email, SMS) will be displayed with the respective duration or volume 

and the price for the respective data call, even if several messages were transferred within 

one data-call. 

Each sub-account optionally receives either a duration based (per minutes) or a volume-

based (per kByte) bill. For details, please refer to chapter "Sub-accounts - Creation". 

Please note: The values stated in this bill may differ from the general monthly bill issued by 

Marlink, as the entered rates are user-defined; The call duration may differ (sometimes 10% 

or more) from the real call duration of the land earth station. 

An export function allows to export the files in CSV format. 
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19.5 SUB-ACCOUNTS – SUB-ACCOUNT MONITOR 

In case you have created several sub-accounts on-board, the sub-account monitor helps you 

to maintain the overview. The sub-account monitor is accessed via SkyFile Mail menu 

"Subaccount" ➔ "Subaccount monitor". 

 

The monitor gives a list of all sub-accounts with the following respective info: 

• New:   number of new unread messages 

• In:  number of received messages in the "new"-archive 

• Out:  number of messages which will be sent in the next data transfer 

• Out size: volume of all messages which will be sent in the next data transfer 

In the sub-account monitor window you can simply double-click on an arbitrary line, to switch 

to the respective sub-account. 

A function available in SkyFile Mail v8.25 and higher, allows you to select the type of accounts 

you wish to see.  

Abbreviations: 

• C   = Corporate 

• P   = Private 

• S   = Prepaid 

• ~[account]  = Prepaid MyMail 

Please note: In case you open the sub-account monitor while being in the master sub-

account (the string "(Master)" will be shown in the head-line), you will be able to easily access 

all corporate sub-accounts without entering the sub-account password. This enables the 
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captain, to conveniently check all corporate sub-accounts, to decide which data should be 

sent before dialing-in, or which data have been received after dial-in. 

 

20. POSTPAID / PREPAID CREW EMAILING 

More and more crew members are asking for an easy to use and cheap solution to send and 

receive emails to and from their family and friends at home, as emails are much cheaper than 

voice calls.  

Thanks to the described sub-account features, SkyFile Mail makes it easy for the captain to 

offer crew emailing: even prepaid crew emailing can be offered with a minimum of 

administrative efforts involved and without additional investment as the available hard- and 

software components on board can be used: 

Thanks to the private sub-accounts, each crew-member can get his own password protected 

on-board email address. 

A separated PC for the crew, connected via LAN, can be installed e.g. in the crew room to 

avoid that the crew need to visit the bridge to check emails. Only the captain is allowed to 

start the email transfer. 

The crew-traffic can be charged on a monthly basis or at any time, e.g. if a person leaves the 

vessel. The bill is very detailed, each message is documented and priced, the captain may 

select between two options: volume- or connection times based billing. In both cases, the 

invoice is well comprehensive and understandable for both, captain and crew. 

Advantage for volume billing: the price per email is already shown when the email is 

created. As well the price per email is shown in the message list. 

The rate for the crew will be defined by the captain. 

 

To avoid unauthorized use, the captain can set a monthly or general traffic limitation for each 

sub-account. After reaching this traffic limit, the crew sub-account cannot produce any 

additional messaging-costs5.  

 

5 Please note that the reception of email stops only after the next dial-in after the limit has been reached! So it might happen 

that the limit set will be exceeded for a certain amount. 
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Prepaid crew emailing: 

In order to offer an easy 

"prepaid" crew emailing 

solution on-board, the captain 

needs to set the billing 

parameters such as: price per 

minute, currency, minimum 

price and  limit (money or 

monthly based). 
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21. SKYFILE MAIL PREPAID – MASTER ACTIVATION  

To use SkyFile Mail prepaid: 

The service must be activated on the SkyFile Mail server.  

Please contact your Service Provider or our Marlink Service Desk. 

• If you use SkyFile Mail prepaid on a SkyFile Mail account where sub-accounts have 
been previously activated and used, please, directly go to point 13.2 

• If you use SkyFile Mail for the first time, please follow those steps. 

21.1 HOW TO CREATE A MASTER / ADMINISTRATOR SUB-ACCOUNT. 

To activate and to use SkyFile Mail in Prepaid mode, a master/administrator sub-account 
must be created. 

Please go to “Subaccount” ➔ “Subaccount configuration” ➔ “New” 

Please complete relevant fields (at least Description, Subaccount name and Password), as 
shown below: 

 

Then validate by “OK”. 

Please select this account as the “master sub-account” 
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Afterwards, SkyFile Mail is closed and restarted automatically to take in charge those 

modifications. 

Please select the master/administrator account previously created, and enter the password. 

Now you are able to activate SkyFile Mail prepaid functions. 

21.2 HOW TO ACTIVATE ONBOARD SKYFILE MAIL PREPAID SERVICE  

To activate SkyFile Mail prepaid service, please go to “Configuration” ➔ “Account & Dial 

Parameters”  

and activate “prepaid” options (1)  

 

Then select “Prepaid options” 

 

Please configure “Prepaid” Options 

• Access mode: since SkyFile Mail v9.00, the access mode is simplified. 4 configurations 

are already suggested to the user: 

o Always use active postpaid configuration (default): in that case Postpaid 

and PrePaid dial in will use the same device. 
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o Always use Primary configuration 

o Always use backup configuration1 

o Always use backup configuration2 

 

• Mail exchange time: A maximum of 6 daily connections can be configured. Please 
configure the time when the prepaid connections will be done. The connection to the 
server is fully automatic at the time configured. Select the connection time accordingly 
with the vessel activity. Prefer a prepaid connection when the business-activity of the 
vessel is reduced (during the night for instance). With a correct configuration, you will 
avoid any problems or conflicts between the regular SkyFile Mail and SkyFile Mail prepaid 
connections. 

• Hourly prepaid dial-in: automatic and silent dial-ins are performed each hour. 

• Connect Prepaid after IP-based connections: after each postpaid connections, a 
prepaid dial in is automatically done. As Postpaid and Prepaid connections are done via 
different ports, please note that the postpaid connections is dropped down before the 
prepaid connection is started. This process avoids confusions and a mix between 
postpaid and prepaid traffic. 

• Prepaid users are allowed to initiate mail exchange: in case of emergency prepaid 
users can send emails immediately (if this option has been activated by the master). An 
additional fee will be charged to the user in any cases and applied on each email or check-
mail done by the user. 

• Allow self-registration: If this option is selected, SkyFile Mail prepaid users will be able 
to create and configure their own SkyFile Mail prepaid sub-account. 

• Attachments generally disallowed for prepaid accounts: in principle each crew-
member manages his own account and generally the rules are defined by the user. 
However, for a better control of the traffic, companies restrict the usage by disallowing 
attachments to all users. 

21.3 HOW THE MASTER CAN CREATE A PREPAID SUB-ACCOUNT 

If the “Self-Registration” option is disallowed, prepaid sub-accounts must be created by the 
master or the SkyFile Mail administrator. 

To create a new prepaid sub-account, please go to “Subaccount” ➔ “Subaccount 
configuration”, then select “New”. Please fill-out the following fields: 

• Description: this is the prepaid sub-account-name which will appear just before the mail 
address <Jack Sparrow> Sparrow.victoria-star@SkyFile.com  

• Sub-account name: this is the sub-account address which will be linked with the main 
SkyFile  Mail account  

mailto:Sparrow.victoria-star@SkyFile.com
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• Password: In prepaid-mode, the password is mandatory. The password must be 
communicated to the prepaid user. It is mandatory to open the prepaid sub-account. 

• Then select “prepaid” or preferably “Create new MyMail prepaid account” 

 

Prepaid sub-account has been successfully created. Now you need to configure it. 

21.4 HOW THE MASTER CAN CONFIGURE A PREPAID SUB-ACCOUNT 

To configure a prepaid sub-account, please select it in the SkyFile Mail log-in page. 

From the SkyFile Mail master sub-account, please click on “change sub-account”  

Please select the prepaid sub-account in the “prepaid sub-accounts” list. 

• Enter the prepaid sub-account password. 

• Confirm the sub-account password. 

 

Now you can configure the sub-account profile of the crew-member or of the passenger. 

For information about configuration of sub-accounts, please see following pages. 

 

 

22. HOW A CREW-MEMBER / PASSENGER CAN CREATE HIS 

OWN SKYFILE MAIL PREPAID OR MYMAIL SUB-ACCOUNT 

To learn more about SkyFile Mail Prepaid & MyMail, please contact our Marlink Service Desk 

or consult our website where a user guide is available. 
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23. KEYBOARD SHORTCUTS AND MOUSE FUNCTIONS 

Besides the editing options in the menu of the email window, some key combinations are 

available. However, when viewing a received or already sent message, the text cannot be 

altered but selected and copied only: 

• F1: Opens the SkyFile manual (help). 

• Ctrl-F2: Defines macros in the mail editor for use with F2, such as fyi = for your 

information. 

• F2 (or double-click): Expands a macro which has been defined with Ctrl-F2. 

• F3: Continue searching (see Ctrl+F). 

• F4: Opens a "new email" window from the mail list. 

• F5: Re-reads the mail list (not required normally). 

• F6: Enables the BCC (blind carbon copy) field when writing an email, or selects 

"answer to all" in the mail list. 

• F7: Add a remark to an email in the message list, or change the spell-check language 

in the mail editor. 

• F8: Moves the selected email into an archive. 

• F9: Inserts the current date and time in the configured system format. 

• F11: Switches between normal and full-screen mode when viewing an email. 

• F12: Switches between fixed and proportional font when viewing an email. 

• Shift+Cursor key: Selects a text area (or drag with the left mouse key held down). 

• Del: Deletes one character or the selected text without copying it to the clipboard. 

• <- Backspace, above the Enter key: Deletes one character left of the cursor. 

• Ctrl+C: Copies the selected text to the clipboard without deleting it. 

• Ctrl+X: Copies the selected text to the clipboard and deletes it. 

• Ctrl+V: Pastes a text from the clipboard to the current cursor position. 

• Ctrl+F: Searches a word, beginning at the cursor position (continue with F3). 

• You will find more common key combinations in the Windows online help. 

You may double-click on an Internet link in the text area beginning with www. or http:// in 

order to open that page in the web browser. Double-clicking on an email address in the text 

area opens another SkyFile window allowing to write a message. 
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24. FAQ 

24.1 HOW TO CHECK IF A SKYFILE MAIL ADDRESS IS SET UP TO BE USED 

IN PREPAID MODE? 

You have to make sure the prepaid box at the bottom of the window is ticked in the SkyFile 

Mail administration. The standard option also needs to be selected in the drop down menu as 

well as the mobile type and the data IMN used for prepaid connection. 

24.2 HOW TO AUTHORIZE A SKYFILE MAIL ADDRESS TO BE USED IN 

PREPAID MODE IF I DO NOT KNOW THE DATA IMN USED FOR 

CONNECTION? 

The Data IMN needs to be filled in for statistical purposes only (except for Iridium where 

verification is done in the prepaid platform). So you can fill out this field with a fake number 

in case of emergency. (Needs to be verified for Iridium) 

24.3 HOW CAN THE SKYFILE MAIL ADDRESS OWNER CREATE PREPAID 

SKYFILE MAIL SUB-ACCOUNTS? 

The captain has to make sure he activated the SkyFile Mail prepaid option in his software first: 

click on “Configuration“ then “Account“ and in the dial parameters you need to tick the box 

“Activate support of SkyFile prepaid“. Then he has to create a private or corporate master 

sub-account before being allowed to create prepaid sub-accounts because all the prepaid 

sub-accounts need to be linked to a master sub-account). 

24.4 CAN YOU USE THE SAME UNIVERSAL CARDTM WITH DIFFERENT 

PREPAID SUB-ACCOUNTS? 

You can use the same card with different prepaid sub-accounts but when this card is used 

either for a phone call or a mail exchange it cannot be used more than once at the same time, 

because it is locked during usage. 

24.5 WHAT TO DO WHEN A UNIVERSAL CARD WITH CREDIT LEFT ON IT 

CAN NO LONGER BE USED? 

Sometimes cards can still be locked in the prepaid platform (TETCO platform). It sometimes 

happens that a card stays locked in the prepaid platform after a regular usage and it cannot 

be used anymore. The customer gets an error message saying his card is already used by 

another account. You need to contact our Marlink Service Desk and they will unlock the 

Universal Card in the TETCO platform. 

24.6 WHAT ARE THE SKYFILE MAIL RULES REGARDING THE SIZE OF THE 

MAIL BOXES? 



 

 

SkyFile Mail | User Guide | Full version © Marlink ● Page 64/70 

The following limits apply for the mailbox: 

• The maximum mailbox size is 10 times the configured mail size limit for this customer. 

• If the customer has dialed the server within the last 2 days, then up to 250 mails are 

accepted if the user has sub-accounts or up to 100 if no sub-accounts are used. 

• If the customer has dialed the server in the last 3 to 10 days, up to 50 mails are accepted. 

• If the customer has not dialed the server within the last 10 days, only 10 mails are 

accepted; the sender will get "mailbox full" for the 11th mail. 

• Special case: For prepaid users, 50 mails are accepted regardless of the last dial-in. 

• Old mails are deleted after 30 days, and a notification is bounced to the sender. 

• Note that a webmail log-in does not count as a dial-in, so it will not increase the mailbox 

size. 

24.7 TO WHICH COUNTRIES AND NETWORKS CAN I SEND SMS 

MESSAGES? 

The SkyFile gateway in the land earth station has its own GSM connection and can send SMS 

messages to most GSM networks worldwide. There are no additional charges for this service. 

In a few countries SMS messages are even possible to fixed users: If the fixed telephone does 

not support displaying messages, the message is read by a speech synthesizer. 

However, no definitive answer can be given to this question because network providers often 

change their roaming lists. Also, even if you can send a message to a specific network, this 

does not necessarily mean that you can also receive messages (answers) from that network. 

Please note that a positive confirmation email to your SkyFile Mail account only says that the 

SMS could be sent to the local GSM network node. It does not guarantee that the message 

will actually arrive in the destination network or at the specified cell phone number. 

The cell phone user can also answer a received SMS message by simply responding to the 

same GSM number where he received the message from. 

24.8 WHAT TO DO WHEN SKYFILE MAIL IS IN GERMAN LANGUAGE EVEN 

THOUGH YOU CHOSE ANOTHER LANGUAGE? 

In fact German is still the default language of the program. German text is within the program 

itself, other languages are in external files. The selected language is stored in the windows 

registry for each windows user. 
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If there are problems with the language files like ENGLISH.LAN, German sentences might be 

visible. Possible causes: 

There was a problem during installation of the update and the ENGLISH.LAN does not contain 

the new sentences. He can check the size of ENGLISH.LAN. It should be 32776 Bytes. But in 

this case he got an installation error message during the installation of the SkyFile 7.0. It 

seems he has the ENGLISH.LAN from 6.3, all new functions are not translated. If any other 

application (virus scanner) blocks the ENGLISH.LAN, it might happen that some sentences 

are not in the selected language.  

 

 

24.9 WHY DON’T I RECEIVE A DELIVERY CONFIRMATION EMAIL ANYMORE 

WHEN I SEND EMAILS TO THE SKYFILE ADDRESSES? 

Confirmation mails are returned to a terrestrial address if at least one SkyFile Mail user has 

sent at least one email to this address. 

This system avoids backscatter which could be sent to fake email addresses as used by 

spammers and viruses. 

It also helps against spammers who might try to validate email addresses by receiving 

confirmations. So if a terrestrial address does not receive any email from any SkyFile Mail 

user from more than about three weeks, no confirmation mails will be sent to this address. 

24.10 WHICH INMARSAT SERVICES ARE SUPPORTED BY SKYFILE MAIL?  

SkyFile Mail supports all connection-oriented and packet-based Inmarsat services: 

FleetBroadband and BGAN (Broadband Global Access Network) has a volume-based tariff 

similar to MPDS and also runs over the Inmarsat satellites as a packet-based Internet access 

with 128 kbps and more. Alternatively, the low-orbit Iridium satellites are available even in 

the polar regions, offering speech and 2400 bps data. The service reliability does not meet 

the GMDSS requirements, however, so Iridium is not sufficient as a distress system. 

24.11 WHAT ARE THE ADVANTAGES OF SKYFILE MAIL COMPARED TO 

OTHER SOFTWARE?  

The reason is simply that SkyFile Mail is specifically designed for the special requirements of 

satellite communications, so it works more reliable and cheaper than conventional email 

programs. Each day many thousands of emails are transferred using SkyFile Mail.  

SkyFile Mail is much faster than other mail programs. The difference in connection time 

between SkyFile Mail and other mail programs are the result of several factors: 
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The MIME-base64 coding of Outlook and similar programs requires 8 bits for each 6 bits of 

net data. SkyFile Mail uses a transparent transfer, which gives 33 % more performance.  

SkyFile Mail compresses typical text, Word, Excel and similar files online, typically saving 50 

% of time.  

The SkyFile Mail log-in procedure is very fast, requiring less steps than the typical POP3 log-

in of other programs. 

SkyFile Mail receives and sends data in parallel at the same time, saving up to 50 % of time. 

Due to the propagation delay, each dialogue step typically consumes more than one second 

over satellites. SkyFile Mail reduces the number of steps for sending and receiving one email 

from 23 (conventional POP3/SMTP over PPP) to only four, additionally saving more than 30 

seconds. 

 

 

24.12 THE EXTERNAL COM PORT OF MY LAPTOP IS NOT DISPLAYED?  

In some cases external serial ports like those in USB or PCMCIA adapters do not appear in 

the device list of most applications so that they cannot be selected.  

If this happens, you should launch the Regedit program and search for this key: 

HKEY_LOCAL_MACHINE\Hardware\DeviceMap\SerialComm 

To activate a COM1 port, for instance, you have to create a new string with the name "COM1" 

and the value "Com1" in Windows 98. For Windows NT, 2000 or XP the string must have the 

name "\Device\Serial0" and the value "COM1". - Please note that changes to the registry 

should be done by experienced personnel only. 

24.13 IS IT USEFUL TO PACK ATTACHMENTS INTO A ZIP FILE FIRST?  

SkyFile Mail uses a very efficient online compression algorithm, which is quite similar to the 

one used in ZIP software. Typical text files are compressed to 50 % or less. 

If you transfer many small attachments in one email, you may save a few seconds of 

connection time by putting all attachments into one single ZIP file, so that you effectively 

have only one attachment. This will avoid the short handshake times between all the 

attachments. 

For typical emails with no or only a few attachments, however, there is absolutely no 

advantage sending them as ZIP files. 

24.14 IS IT POSSIBLE TO REDIRECT MY SKYFILE MAILBOX OR TO 
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RETRIEVE IT VIA ISDN? 

You can redirect a free mail account like GMX, Bigfoot, Yahoo or others to your SkyFile Mail 

address while you are using your satellite transceiver. When you are back home, simply 

deactivate this redirection at your free mail provider. However, we recommend not to use 

such a redirection because it makes filtering spam very unreliable. 

Your SkyFile Mail account cannot be redirected to a different email address - the server and 

its backbone connection are not intended for this sort of usage, since it would increase the 

data volume of the mail gateway significantly. This traffic could also slow down the server 

response and therefore increase the cost of exchanging mails via satellite, which of course is 

not intended. 

You can use the web interface of the SkyFile server to read, answer and forward received 

emails with any web browser. The same username and password combination is required as 

for SkyFile Mail, but the web function is enabled on explicit request only to avoid any misuse. 

Mails for private sub-accounts are not displayed for privacy reasons. Please ask our Marlink 

Service Desk for the required access data. 

24.15 WHAT CAN I DO AGAINST UNWANTED MAILS (SPAM)? 

The gateway has a built-in spam filter which will block most unwanted unsolicited emails. 

Due to the nature of such mails, however, a few spam mails may still get through. If you are 

frequently offended by emails from one specific sender, please inform our Marlink Service 

Desk. 

We do not recommend to forward emails from a mailbox at another mail provider like Google 

Mail, Hotmail or Yahoo to your SkyFile account. Since the servers of these services are treated 

as trustworthy by the SkyFile server, spam detection cannot work as good as for servers 

communicating directly with the SkyFile gateway. 

A very restrictive way is to only allow incoming emails which have a specific password in their 

subject. This means that all emails not having this word in the subject will be deleted, and 

their sender gets a return mail with an error message (access denied). 

Another mechanism is using a black & white list which can be managed from a previously 

registered email address. Typically it will only consist of a white list (+) with addresses being 

allowed to send emails to your mobile account. 

The account management at Marlink can also set file size limits for attachments in emails 

directed to your account. Especially if you are using a slow service, this limit should not be 

set too high. 

During the reception of a long email you can abort the transfer of a file by pressing the "reject" 

button in the transfer software. This file will then be deleted on both sides, and the transfer 

will continue with the next file or email. 
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24.16 IS IT POSSIBLE TO USE SKYFILE MAIL IN A NETWORK WITH 

SEVERAL PCS? 

Yes! Simply define the hard disk drive of the PC connected to the satellite transceiver as a 

network resource, e.g. "c" for the local disk "C:". Please see the built-in help of Windows for 

details how to create a network resource. On all other PCs within the local network, the 

Autosync.exe program can then be launched from the network, e.g. using a desktop link, 

instead of installing SkyFile Mail on all PCs. 

For instance, if the machine name of the PC with the cable to the satellite transceiver is "pc1" 

and SkyFile resides on its local drive C:, other workstations can access SkyFile Mail by simply 

using \\pc1\c\skyfile\autosync.exe as a desktop link. Alternatively, if workstations are using 

mapped drives like N: pointing to \\pc1\c, they can access SkyFile Mail using 

N:\skyfile\autosync.exe. 

Typically each workstation uses its own sub-account name and thus has its own email 

address. It is also possible to access a specific mail account from different PCs alternatively, 

though this should not be done at the same time. 

To ensure that the mail list and the archive tree are automatically synchronized between all 

workstations with the internal firewall of Windows XP enabled, "File and printer sharing" must 

be allowed in the firewall for local LAN addresses even if the sharing service is not really 

activated. 

If SkyFile Mail has been configured for an automatic dial-in with a specified timing or for using 

sub-accounts, then the transfer module is started automatically on the PC connected to the 

satellite terminal. This ensures that internal emails from one sub-account to another are 

delivered immediately without having to go through the satellite link. 

24.17 HOW CAN I SEND AN SMS MESSAGE TO A SKYFILE MAIL USER? 

You can send SMS messages to SkyFile Mail users only after you have received one from the 

SkyFile gateway, so you can see the GSM number of the gateway. All SkyFile Mail users have 

the same GSM gateway number. There are two ways to send an SMS message: 

You answer the SMS message, using the same cell-phone number as in the message you have 

received. The SkyFile gateway has kept in memory your mobile number and routes your 

answer to the user who had sent you a message before. No additional addressing is required. 

However, please do not use a colon ":" after the first word of your message in order to avoid 

any misinterpretation of this word as an address.  

If you want to send an SMS to a SkyFile Mail address from a different mobile phone or from a 

web-based SMS service you will have to write the recipient's user name and a colon at the 

beginning of your message. Example: ANDREA1: Hello, thanks for your message... 

Upper or lower case is not relevant in the username.  

file://///pc1/c/skyfile/autosync.exe
file://///pc1/c
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Please note that the successful delivery of your message to the satellite gateway depends on 

whether your local GSM provider has a bi-directional interworking agreement with T-Mobile 

or not. 

24.18 HOW DOES BLACK AND WHITE LIST WORK? 

“Black” entries: define terrestrial email addresses or even email domains, which are not 
permitted to send messages to your terminal(s). 

“White” entries: define terrestrial email addresses or even email domains, which are allowed 
to send messages to the terminal(s). Once a “white” entry exists, all other unspecified email 
addresses are automatically “black”, that means, only the "white" list entries are permitted 
to send emails to the respective SkyFile Mail account(s). 

We have two kinds of black & white lists: The prepaid function and the existing black & white 
list for postpaid accounts. Both lists are implemented in the same way: 1. List with only '-' 
entries: all non-matching addresses are allowed: 

• hotmail.com 

• yahoo.com 

2. List with only '+' entries: all non-matching addresses are forbidden: 

+company1.com 

+company2.com 

1. Mixed lists: all non-matching addresses are allowed! 

+good_friend@hotmail.com 

hotmail.com 

+good_friend2@yahoo.com 

yahoo.com 

With these rules it is possible for you to exclude all unknown addresses from a 
spammed domain, but you are able to receive emails from your friend. 

  

mailto:+good_friend@hotmail.com
mailto:+good_friend2@yahoo.com
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25. Need Support? 

If you have any questions, please contact your Key Account Manager or Marlink Service 

Desk: 

 

Email:  servicedesk@marlink.com  

EMEA:  +33 (0)1 70 48 98 98 

Americas:  +1 (310) 616-5594 

 +1 855 769 39 59 (toll free)  

Asia Pacific:  +65 64 29 83 11 

 

http://www.marlink.com 

 

mailto:servicedesk@marlink.com
http://www.marlink.com/

